OVERVIEW

This section describes how to use the course materials and software applications you have received in preparing for the CPA Exam. Review this section before starting the course to familiarize yourself with how Becker’s CPA Exam Review system works and how to use each tool effectively.

STUDY PLANS

Study plans are an essential success element in the Becker approach. Before you begin studying for any exam part, you will have the opportunity to create a study plan using the Study Planner tool. This tool will design a weekly action plan based on the number of hours you have available for preparation and your intended exam date. If you haven’t yet scheduled your exam, the Study Planner will recommend an exam window based on information you provide during the plan creation.

Once a study plan has been created it becomes your primary interface for navigating through course content. You can modify your study plan at any time, print it for easy reference, or export it to Microsoft Outlook so that your study time and tasks are integrated into your calendar.

STUDY ROADMAPS

Learn

View the National Instructor's presentation of the lecture.
Whether you attend a live classroom, view the lecture via our online course, or use the exam review course, our National Instructors will walk you through the material. They will summarize and prioritize the materials, highlight key points, and give you tips on learning the materials along the way. After a topic has been discussed CPA Exam questions related to that topic are worked during the lecture to show you how the topic will be tested on the actual exam.

Classroom students should attend every class and make up any class missed.

Online or self-study students should view each lecture in its entirety. Lecture discs are required for each lecture for the self-study course. To improve your self-study course experience, lectures may be copied to your computer's hard drive. You will be prompted to install lectures the first time you begin studying and selecting a lecture or homework to work on.

Practice

Complete homework.
Doing the homework is an essential part of preparing for the exam. Use homework as an additional learning tool, not a testing tool. Do the homework for each lecture as soon as possible after viewing the lecture. You should plan on spending approximately 1 ½ hours on homework for every hour spent viewing the lecture. Your homework is a learning tool. You should understand why the correct answer is correct and why the incorrect answers are incorrect.

In your first homework session for each lecture, go through all the questions. Answer each question and review the explanations. Refer to your notes on topics that give you difficulty. In subsequent sessions, rework the questions you answered incorrectly. Repeat this process until you have answered each question correctly. If you have the time, complete the supplemental questions in the same manner.

Complete simulations.
The homework simulations have been designed with two main goals in mind:

- To reinforce the materials.
  Each lecture has at least one simulation directly related to the topics of that lecture. The questions in each simulation will further enhance your understanding of the materials.

- To familiarize you with the computer-based exam.
  These simulations have been designed to look and act like those you will see on the exam. Working the homework simulations gives you the opportunity to completely familiarize yourself with the software you will use on the exam.
Review

Review the materials on your own and create flashcards.
An integrated aspect of our course is the use of flashcards to help candidates learn important concepts. We recommend that you create your own flashcards. However, if you are pressed for time, we do offer a comprehensive flashcard series in both traditional paper and mobile app formats. Flashcard apps are available for iOS™, Android™, and Blackberry™ devices.

Tips for using flashcards as a study aid:

- Make flashcards as you review your lecture notes and before doing the multiple-choice or simulation homework. Making flashcards is an effective learning process because the act of creating them reinforces the material. The cards are especially helpful for memorizing mnemonics, formulas, and highlighted items in your textbook outlines marked "memorize" or "heavy on the exam."
- On the front of each flashcard, write the title or question of the major points you are trying to memorize, and on the back write the answer or information.
- Keep your cards with you at all times so you can quiz yourself whenever you have time.
- Select major concepts from the workbook outline, especially the following:
  - Mnemonics, formulas.
  - "Heavy on exam" notations on workbook outline.
  - "Memorize" notations on workbook outline.
  - Major concepts you note while reading the explanations to your multiple-choice homework.
  - Concepts you have difficulty understanding.
- Keep answers simple. It is important for your learning to synthesize the question and the answer.

Do progress tests.
Progress Tests assess your knowledge across a single topic or multiple topics as you prepare for exam day. These tests draw from Becker's extensive question item bank and can be taken repeatedly to build endurance and speed.

PERFORMANCE AND STATISTICS
Dashboard displays of your progress through the course and mastery of each topic area provide at-a-glance visibility at your readiness as exam day approaches. The Performance and Statistics module of the software enables you to pinpoint weak areas for added focus during reviews and develop your exam day game plan.

REVIEW BEFORE EXAM
Before sitting for the exam, you should do a comprehensive review of the materials.
The review should be completed between the end of the classes and your scheduled exam date. Allowing two weeks for review is strongly recommended. This review should include the following:

1. Rework
   - Homework questions
     You should plan on reworking all the homework questions in Exam Review during your final review. Begin with the first lecture of the part you are preparing for and continue through the last lecture. Supplemental questions are an additional source for reviewing the materials. In particular, work these if you skipped them during your weekly study sessions. Your rework should include reviewing the answer explanations for all questions, regardless of whether you got the question right or wrong.
   - Simulations
     Part of your final review should incorporate reviewing and/or reworking the simulations previously worked for homework. Familiarizing yourself with the user interface and functionality of the simulations is very important.

2. Take Final Exams
Each of the four topics contains a final exam. The final exams have been designed to give you a realistic exam that is very close to what you will see at the exam site. It contains both multiple-choice questions and simulations (where applicable). You should plan a block of time equivalent to the actual exam time for each section in order to take this final exam in its entirety.

Following is the length of each exam:
Auditing & Attestation – 4.0 hours
Financial Accounting & Reporting – 4.0 hours
Regulation – 3.0 hours
Business Environment & Concepts – 3.0 hours

3. Comprehensive Progress Tests
Comprehensive Progress Tests are provided to give you additional exam preparation experience right up to exam day. Comprehensive Progress Tests help build endurance and speed, ensuring you’re in the best possible shape for your exams. Because these tests provide questions across a range of topics, we recommend that homework question files from each Startup Disc be copied to your computer’s hard drive to avoid the need for disc changes that can interrupt your study sessions. You will be prompted with this option when you begin a Comprehensive Progress Test.

TECHNICAL HELP AND SUPPORT CENTER
Technical help and academic support are available on the web 24x7 and via telephone between 7:30am - 7:30pm CST.

Updates and Support Center
The Becker Support Center (http://beckerkb.custhelp.com) is your source for course updates, supplemental materials, software downloads and unlimited academic support. You can also access the site from www.becker.com.

Customer Service
Call 1-877-CPA-EXAM (Outside the U.S. 1-630-472-2213) or visit http://becker.custhelp.com.

Technical Support
Becker’s CPA Exam Review (In-class, Online or Self-Study): Call 1-877-CPA-EXAM (Outside the U.S. 1-630-472-2213)
Online Course: Call 1-866-866-7053 or visit https://supportcenter.embanet.com/becker
Self-Study: Call 1-877-784-1997 (Outside the U.S. 1-630-574-1997)

Have your product, serial number, and computer available.
When you begin the course application, the Home Page displays your *My To-Do* items in list or calendar format. By default, the main pane of the Home Page displays lectures for each exam module you have purchased in list view.

The *Options* tab enables you to view your study *Performance and Statistics*, create and modify your *Study Plan*, and use *Tools* to adjust course software settings and locate specific questions in the homework question bank. These options will be discussed in detail later in this guide.
Help and Tutorials

Before attending the first class or starting your study plan, view the Course Introduction tutorial in the Help area for a quick overview on the software. This multimedia video provides valuable information about the course and how to use the tools available to you. This Course User Guide and the Course Software Manual, as well as National Instructor Biosa are also available in the Help area.

STUDY PLANNER

The Study Planner will walk you step by step through creating a custom study plan, including suggestions on when to schedule your exam dates and a weekly plan to successfully prepare for each exam. Although you may use the software without creating a Study Plan, this documentation assumes that users will create and follow a study plan. Once you have created a study plan, the software will provide you with many tools to keep track of your progress through the course.

Click Create Study Plan to start the Study Planner.

Select the study plan preparation option that best describes your study situation. Video tutorials about each method are available. To move to the next step, click Next.
Click the check boxes next to the parts of the exam for which you will be preparing and click Next.

If you have scheduled an exam date, select that date from the options provided. If you haven’t scheduled a date, select I don’t know. Customize your study plan by indicating the number of hours per week you plan to study and when you intend to begin your work. The Study Planner will calculate a week-by-week study schedule factoring your planned study time and, if provided, the exam date. If you did not provide an exam date, the Study Planner suggests an exam window for scheduling.

You can modify the options in the Study Planner to change your study plan at any time.

Once your study plan is complete, you can print the schedule or export your plan to Microsoft Outlook.
Once a study plan has been created, the Home Page will display tasks that need to be completed in the My To-Do area, with List and Calendar views of all tasks related to the study plan in the main pane.

Use the Options tab on the Home page to manage and modify your Study Plan:

Click Change Study Plan or Exam Date to revise details of your existing study plan.

Click Delete Study Plan to delete the study plan you have created.

Click Print Study Plan to revert to print the details of the plan.

Click Export Study Plan to MS Outlook to create tasks on your calendar that map to items in your study plan.

In the List or Calendar view, click any row to open the Study Center for that lecture:
The Study Center organizes each exam topic using Becker’s proven preparation approach: **Learn, Practice, Review**. The Study Roadmap provides a dashboard view of both the time required for each topic element as well as your progress on each topic element as you progress through the lecture, homework and simulations, and review.

### LEARN

The **Learn component** allows access to lectures for each topic.

Click **View Lecture** to get started. A detailed view of the lecture topics is provided in the main pane, with overall topic status indicators in the left pane.

**NOTE:** A Lecture DVD is required for each lecture. You can avoid the ongoing need for Lecture DVDs by choosing to copy all lectures to your computer when prompted.
Click any row in the lecture topics to start the lecture for that section. The course application will prompt you to insert the appropriate Lecture DVD. Becker highly recommends that you choose the option to copy lectures to your hard drive to improve the course experience.

The multimedia content of each lecture is broken down by corresponding text page and class question. These are listed in the Table of Contents along with the duration of each item in the left pane. Lecture Run-Time shows your current position in the lecture and the amount of time that remains. To expand the lecture window area, hide the Table of Contents by clicking the in the upper left corner of the Table of Contents area. Unhide the Table of Contents at any time by clicking .

Tools to pause, play, and navigate through the lecture content are located at the bottom of the screen.
Duration indicates your position within this portion of the lecture.

Click the **blue arrow** to play or pause the video. Click and drag the **white button** in the progress bar to fast forward or rewind the lecture.

Drag the button to the right of the speaker icon to increase or decrease the volume.

Click the **Closed Caption** icon to hide or show a text transcript of the video as it plays.

During the lecture, you may be asked to work questions from prior exams related directly to the topic being lectured:

When a question appears, try to work the question on your own.

Then, click **Answer** along the bottom of the screen to see the detailed answer to that question.

Click **Explain** at the bottom of the screen to view a multimedia explanation of the question.

Finally, click **Continue** to resume the lecture.

Click **Back** in the upper right corner to return to the **Study Center**.

When the topic is completed, lecture playback will stop, and you will be automatically returned to the **Study Center**.

As with other elements of the **Study Center**, each topic that has been viewed will have a line drawn through it to indicate that it has been viewed, and a check mark will be placed next to each lecture you have completed. You may view all or part of a lecture you have already completed as many times as you wish.

Click **eBook** to access annotated lecture notes for this topic.

Click **My Notes** in the upper right corner to take your own notes. A full suite of standard editing tools are available for PC users.

Click **Home** to return to the Home Page at any time.

---

**PRACTICE**

The **Practice component** allows access to each topic’s homework. Click **Complete Homework** to enter and begin a **Homework** assignment. It also allows you to work on a **Simulation**.
The Topic Statistics Summary dashboard displays statistics, history, and options in a graphical way that makes it easy to see where you are. As you build history within the topic additional indicators of completion and mastery will be provided in the scrolling module.

The Topic Statistics Summary box shows an overview of the statistics for the topic as follows:

- **First Attempt** – shows the cumulative statistics for the FIRST time you have answered the questions in a topic. A low Percent Correct value (less than 90%) for this statistic may indicate a weakness in that topic, and additional review of the materials may be required.

- **Last Session** – shows the statistics of the last homework session attempted for this topic. This is NOT cumulative; it only shows how you did the last time you attempted the homework for this topic.

- **Overall** – shows the overall status of the homework for the topic (see the previous section). This is the most important statistic for each topic. When the Percent Correct column for this statistic reaches 90% or higher, the homework assignment for that topic is marked as complete.

Scroll down the Summary window to view your homework history. The homework history logs the results of your past homework history. It shows the summary of every homework attempt you have made for this topic in chronological order.

Use **Homework Session Options** to allow you to customize your next homework session for the topic. Your choices are as follows:

- **All Questions in the Topic** – Selecting this criterion will include all the questions in the topic. You should use this option during your final review.

- **Unanswered/Incorrect Questions** – This is the default criterion for filtering questions. This will include the questions you have not yet answered or have not yet answered correctly (at least once). You should use this option during your normal homework sessions.

- **Marked Questions** – Selecting this criterion will only include the marked questions. Marking questions is an effective method in which the software automatically recalls questions you have specifically marked yourself. This is further explained later.

The number of questions that will be included in the homework session will adjust accordingly as you select these options.

The **Start Homework** button will be disabled when there are no questions to include.

After selecting your **Homework Session Options**, click **Start Homework**.
The questions will appear in the main pane; detailed statistics about the current session will be shown in the left pane:

If you have opted to have questions graded as you answer them, a correct answer selection will change to green. The answer selection will change to yellow when an incorrect answer is given; the correct answer is provided in the feedback area at the bottom of the screen.

You may change your answer as many times as you wish, but only the first answer will be recorded. 

**Question Statistics** indicates how many times you have worked the current question, and shows the history of past attempts.

**Session Statistics** indicate the total number of questions worked for the current session and the number and percent of successful responses.

**Time Spent/Question** indicates the amount of time you have spent on the current question. 

**Time Spent/Session** indicates the amount of time you have spent on all questions in the current session:

Use the navigation tools at the top of the screen to navigate through the homework questions.

The zoom buttons magnify or shrink the text.

Click **Answer** to view a detailed explanation of the answer in a separate window. This button will be activated when you have answered the question.

Click **eBook** to view the related **eBook** pages for this question in a new window. To close the **eBook** and return to the homework item, click the standard Close window control (X) in the upper right corner.

Clicking the **Lecture** icon will open a window to the lecture segment related to this question. Close the window to return to the **Homework**.
Use the Marked option to indicate specific questions to mark for later review.

Pull down the Options menu to change when grading occurs.

Clicking Support Center will open a Web browser. From there, you may search for answers, ask a question, and subscribe to receive email notification when updated content is posted.

Click Calculator or Spreadsheet to open up a new window with these tools, or Print to print the question.

Click End when you are ready to stop working. A dialogue box will display the results of this session, and you will return to the Homework dashboard. The dashboard will be automatically updated to include the progress made during your most recent study session.

How to Complete the Homework
Please refer to the Homework section earlier in this manual for a detailed description of how you should do your homework. Below is an overview for your convenience.

- In your first attempt, answer all the questions in a topic.
- Do the homework again, but this time rework the questions you answered incorrectly.
- Repeat this process (reworking incorrect questions) until you have answered each question correctly.

Becker's CPA Exam Review uses this methodology to determine whether you have completed the homework for a topic. When 90% (or more) of the questions of a topic have been answered correctly at least once, the homework for that topic is considered complete. To accomplish this, the software keeps an overall statistic for each question. Once a question has been answered correctly, it is marked permanently, and the overall status of that question is computed as correct regardless of how the question is answered in future homework sessions. When 90% or more of the questions in a topic have an overall status of correct, the topic will be marked as complete.

Homework Simulations
Becker's Simulation is designed to give you hands-on experience with the computer-based test and simulations that you will see on the actual CPA Exam. To begin working on a simulation first click Simulation.

Navigating the Simulations
The simulations home screen menu, below, consists of directions followed by a subset of topics to assist the user in completing the individual task-based simulations.
To navigate from task to task, use the controls at the bottom of the screen. Click on the **Next** button to advance to the next task, or the **Previous** button to go to the previous task. If you would like a reminder to revisit a task, or want to indicate that you are finished with it, click on the reminder flag below the task number. To clear the flag, click on it again. Reminder flags are for your use only – they do not contribute to your score.

Every task within the simulation has one or more **Work Tabs**. All tasks in the AUD, FAR, and REG sections will have an Authoritative Literature tab for your reference. (See below for a complete description of how to use these tabs). Some tasks will have one or more **Information Tabs**, others may have none. Every task has a **Help** tab. If a task has an information tab, you may use the information in them to complete your responses in the **Work Tab**.

In the tool bar you will find buttons to access the tools available to you. The **Calculator** button will open the calculator window. This is the only calculator you will have access to on the exam. The **SpreadSheet** button will open the spreadsheet window, which you can use as an electronic "scratchpad" to do any necessary calculations.

The **Solution** button will display the answer(s) and the explanations of each tab. It becomes active when you select any work tab. Please note that on the actual exam this will be the Help button. Click the **Split Vert** or **Split Horiz** buttons to split the simulation window into two panes. The split functionality is explained in more detail later. Click **Exit** to exit out of the simulation.

In the tool bar window you will also see the timer for your reference.

The questions or requirements of a task and the information needed to complete them will be provided to you within the work tab.

A pencil icon next to the title of the tab identifies it as a **Work Tab** and indicates that some requirements must be answered in that tab.

The **Work Tab** will provide instructions on exactly what is required in order to complete the task. Places where an entry is required will be shaded, and the instructions will explain how to answer each shaded area.
TIP: You should work the task-based simulations as follows:

1. Briefly review the requirements for each work tab.
2. Allocate your time among the tasks based on the requirements. The timer runs as a guide.
3. Begin working the first task.

Simulation Task Formats
The simulations have several types of task formats. Following is a description of each type of tasks you may find in the simulations. Some tasks may include more than one format.

Direct Entry Tasks
In this type of task, you will be asked to enter a value directly in a shaded cell of a spreadsheet. These are primarily numerical values that you calculate yourself. To answer this type of a requirement, click in the shaded cell and type in the value using the keyboard.

Pop-up Tasks
In pop-up type tasks, you will be asked to click on the shaded cell of a spreadsheet and select an item from a list. When you click on a cell with a pop-up, the Select Item pop-up window will appear automatically.

You must then select an item from the list by clicking on it. When you click the OK button, the item you had selected will be placed in the cell automatically.
You can move the pop-up window by clicking on the title bar of the window and, while holding the mouse button down, dragging it in any direction.

**Form Completion Tasks**
In some tasks you may be asked to complete a particular tax form. In such cases, you will see the actual tax form inside the tab with the requirements shaded.

Click each *shaded area* and type in the text or numeric value requested.

**Multiple-Selection Tasks**
In this type of task, you will be provided with a list of choices and will be asked to select several choices that apply to the question being asked.

To select one of the choices, click the *check box* next to the choice. A check mark will appear inside the check box indicating that you have selected that choice. Clicking the box again will remove the check mark. Typically, these types of questions indicate how many choices must be selected. In such cases, you can only select the indicated number of choices at a time. To change your selection after selecting the maximum number of choices, you must first uncheck one of your checked selections.
Research Tasks
To complete research-type tasks, you will have to access the authoritative literature sources. For questions in the FAR section, you will have access to FASB Codification literature. In the Auditing section, you will have access to the Professional Standards literature, and in the Regulation section, you will have access to the IRS Tax Code.

The question or specific instructions for the research question are found in the Research work tab. You must search and locate the appropriate literature to answer the requirement. Once you select a section of the literature in the Authoritative Literature tab, you will make your answer selection in the Research work tab.

The Authoritative Literature tab contains three major areas. The navigation and search tools are on the top of the window, the table of contents hierarchy is on the left pane, and the document pane is on the right side of the window.

The Table of Contents and document panes can be resized. Move the mouse over the border between the two panes until the cursor changes. Press and hold the left mouse button to drag the border into the position you desire, and then release the mouse button. You can find a particular document in two ways. The first is to navigate through the Table of Contents hierarchy. The second is to use the search feature. The Table of Contents topics are grouped by folders. To navigate through the hierarchy, click on the folder link to expand it and reveal the underlying folders or documents.
Folders and documents are distinguished by the icons to the left of the title. Clicking on a folder will display all the paragraphs of that section in the document pane.

You can scroll down in the document pane to see all the paragraphs of the section you have selected. You can also go directly to a subsection or paragraph by clicking on it in the Table of Contents pane.

As mentioned earlier, the literature in the course is a subset of the complete library of literature. As a result, you will see sections of the literature showing as Wrong Path. This indicates that the correct citation is not in that section of the literature. The subset included in the course provides good samples during searches and plenty of opportunity for you to practice with the functionality of this portion of the exam.
Using the Search Features

There are two ways to use the search feature: **Keyword Search** and **Advanced Search**. To find a document using the keyword search, simply type a keyword or phrase into the search textbox at the top of the screen and click **Search**.

The **Advanced Search** feature allows you to refine the search criteria in a number of ways, such as exact phrases, synonyms, and alternative words.

**TIP:** It is recommended that you use the keyword search function rather than the Table of Contents hierarchy to locate a document. Keywords for various items have been included in your texts and are indicated by a magnifying glass icon. These terms are examples of search terms you could use on the exam.

The results from either search option will be displayed in the document pane.

The **View** drop-down allows you to control the amount of each document displayed under each document's title. The range is from Title, which displays only the title, to Long, which displays a significant portion of the document.
The phrase(s) you searched will be highlighted throughout the document. You may need to scroll down or up in the document pane to see all the paragraphs of the selected section. Once you have identified the correct paragraph, click back to the Research work tab and enter in the appropriate paragraph citation in the shaded box.

Note that you may have to scroll in the answer option area of the Research work tab to find the correct option.

You may change your answer at any time. Select another paragraph from the selected list, or find another section of the literature (by a new search or through the Table of Contents) and select the new answer within the shaded area.

SIMULATION TOOLS

Using the Calculator Tool
Click Calculator to display the calculator window.

This is the only calculator you will have access to on the exam. As with other windows, you can move the calculator window by dragging the title bar of the window. To close the window, click Close in the upper right corner of the calculator window.

Using the Spreadsheet Tool
Click Sheet to display a spreadsheet that functions similarly to popular spreadsheet applications such as Microsoft® Excel. The spreadsheet tool is provided to help you complete complex calculations on the exam.

You may enter numbers, text, or formulas into any cell. Use your keyboard arrow keys to navigate through the sheet, or simply click directly onto a cell to access it.
Note: The Spreadsheet tool used in this software and on the exam is NOT as robust or powerful as commercial spreadsheet applications such as Microsoft Excel. The tool provides very basic spreadsheet functionality.

Using the Split Window Feature
You can split the screen horizontally or vertically to view any two tabs simultaneously. The *Split Horiz* button allows you to split the screen horizontally:

You will see two panes, each listing all the simulation tabs. You can view any two tabs simultaneously, but you cannot view the same tab in both panes.

The *Split Vert* button allows you to split the screen vertically.

When split vertically, you will not be able to see all the simulation tabs in either pane. At the edge of each pane, there will be horizontal scrollbars that allow you to scroll to the tabs in each pane. Just as with the horizontal split, you cannot view the same tab in both panes. In either split mode, you can resize the panes by moving your cursor over the dark line between the two panes until the cursor changes and dragging it (up and down in horizontal mode or left or right in vertical mode).

Click *Unsplit* to return to a single-pane view.

Simulation Solutions
Click *Solution* on the tool bar to reveal the answer to a tab.

The solution for the selected tab will display in a separate window. You can move the two windows on the screen as desired. Click *Print* in the solution window to print the solution. Click *Exit* to close the solution window.

**TIP:** We recommend working each tab and reviewing the solutions. We have not provided an automatic grading mechanism on the simulations; however, after taking the final exam you will receive summary results. You should attempt each requirement in the simulation on your own, and then use the solution to review and correct your work.

Written Communication Questions (Tasks)
The BEC exam will include a testlet with three (3) written communication tasks that require you to write a memo or other correspondence. For more information on how to effectively answer written communication tasks, please view Becker’s Written Communication Lecture, which is part of the BEC Course.

Type your answer in the simple word processor provided. As you can see, simple tools such as *Undo, Redo, Cut, Copy,* and *Paste* are available. The word processor has a spell checker that identifies misspelled words as you type. Misspelled words are underlined in red. To fix a misspelling, right click anywhere on the misspelled word and a list of potential corrections will appear.
REVIEW

When you have completed all of the items for a given topic or wish to review specific items in a test like environment, use the Review component to learn about studying with Flashcards or complete a Progress Test. You will have questions randomly selected from the previous topics you have worked on.

Click Do Progress Test to access the Progress Test controls.

To create a new test, select number of questions you wish to include in the progress test and the allotted time per question. You will be allowed to remain on a question longer than the allotted time set. Increasing the number of questions and reducing the allotted time per question on successive progress tests helps build endurance and speed as you approach exam day.

You may also review previously-taken progress tests by selecting Saved Test and choosing from the list of previous tests the one you wish to review. With this feature, you have the ability to reset your previously saved answers and/or adjust the time limit per question.

Click Start Progress Test to start the test. The test screen will then appear displaying the first question.

The progress test functions very much like the homework screen. Answer the question by clicking on the radio button or text. The next question will then display if you selected the option to Automatically go to the next question when an answer is selected before starting the test. You can navigate through the questions using the navigation buttons at the top of the screen.
When you have completed the test click End.

You will then see the result of the exam. Click Review Test at the bottom of the screen to go over the exam. You can also print your results.

You will see each question on the exam, an indication of whether you answered it correctly or not, and an explanation of each question.
The **Review Before Exam** module, accessed from your **Study Plan**, guides you through the final stage of preparation for your upcoming exam. Here, you have the opportunity to rework **Homework** and **Simulations** across the entire exam part curriculum, take **Final Exams**, and work through **Progress tests**.

The features and functionality of each of these tools is identical to those in the lecture-specific versions found in the **Study Roadmap**. The content, however, is comprehensive, crossing all topics that can be covered by the exam.

**MULTIPLE-CHOICE FINAL EXAM TESTLETS**

The multiple-choice testlet screen contains three sections: the **tool bar** at the top of the screen, the **question area** in the middle, and the **question navigation area** at the bottom.

The tool bar indicates the number of questions in the testlet and the time remaining to complete the entire exam. It also displays the **Calculator** tool and an **Exit** button.

**TIP:** When taking the final exam, note that the time remaining is the time left to complete the entire exam. You will not be able to view subsequent testlets before completing and submitting the current testlet. Therefore, you must be very aware of the time remaining in your exam.

Use the **Previous** and **Next** buttons at the bottom of the screen to navigate through the questions. You can also click on a question number to go directly to that question.

If you would like a reminder to revisit a question, or want to indicate that you are finished with it, click on the reminder flag below the question number. To clear the flag, click on it again. Reminder flags are for your use only – they do not contribute to your score.

**NOTE:** You can only review the questions while you are still in a particular testlet. You will not be able to go back to a testlet that has already been submitted, and you may not go forward without submitting the current testlet you are working in.

**Submitting a Testlet**

Once you have completed the testlet and are ready to move to the next testlet, click **Exit** in the upper right corner. You will see the **Review** screen.

Click **Continue Exam** to advance to the next testlet. This will end your access to the testlet you have just completed. Click **Quit Exam** to exit the test completely. If you quit, you will not be able to return to the exam, and you will receive no credit for any questions not answered or any testlets not taken. Click **Review Testlet** to go back to the last testlet you were working on.

When you choose to continue, you are given the option of taking a break. **If you choose to take a break, the exam clock continues to run, both in the final exam and in the actual CPA Exam.** There may also be specific procedures in place at the exam sites regarding when or how you can take a break.

Click **Continue Exam** to continue the exam.

These simulations function in exactly the same way the homework simulations do. However, no solution button is present until the exam is completed. Follow the instructions for each tab, navigating as discussed in the simulation module.

**REVIEWING THE FINAL EXAM RESULTS**

Once you have completed all of the testlets, the **Final Exam Results** are displayed.

Click **Print** to print the summary results. Click **Exit** to exit the exam.
Click **Review** to review the entire exam. In the **review screen** the question or problem is displayed in the top pane; the explanation for the answer is in the bottom pane.

Correct answers are indicated in green, incorrect answers in yellow and unanswered questions in blue. The same color scheme is used on the question numbers.

Click **Continue** to review the next testlet.

After you have reviewed the multiple-choice testlets, the **simulation testlet results** will appear.

The same two-pane display is used to show the answers for each tab in the simulation. As you select a tab, the explanation for that tab appears in the bottom pane. The same color scheme is used to indicate the status of each requirement in the simulation.

The most recent exam result is saved when you exit a final exam. Upon choosing the final exam module again, you will have the option of reviewing your last results or retaking the same exam.
PERFORMANCE AND STATISTICS

Performance Summary

From the Home Page, Options tab click Performance Summary. The Performance Summary provides a visual dashboard view of your overall progress across all topics for an exam part.

Select any lecture or topic from the Table of Contents to view your progress in that area of study.

Click Summary Report to view a complete report for all lectures viewed and homework completed. This report may be printed and included in your application for the tuition waiver programs.

Click Reset Stat to erase all your performance data for the selected course(s).

Warning: Resetting your statistics will erase ALL your performance data for the selected course(s). As a precaution, we highly recommend that you export your current statistics (using the Import/Export/Upload link in the Home Page) and keep the file in a safe location.
UPLOADING YOUR STATISTICS TO THE ONLINE COURSE

If you are enrolled in the Online Course, you have the option to have your statistics uploaded to the Online Course grade book automatically. To do so, click the **Upload to Online** link in the **Options** tab of the **Home Page**. You must then provide your Online Course **User ID** and **Password**.

You can only upload your statistics automatically if you have Internet access on the computer you wish to upload from. When you start the export process, the **Export Wizard** will attempt to verify the user ID and password you have provided BEFORE uploading the statistics to the Online Course servers. If an Internet connection cannot be made, or if the user ID and password you have provided cannot be verified, the upload (and export) process will be halted.

When your statistics have been uploaded successfully you will see a screen indicating this fact. Statistics uploaded to the Online Course servers are processed every day at 4:00 a.m. Eastern Standard Time. Therefore, you will not see your statistics reflected in your grade book until that time. An e-mail will be sent to you when the process is completed.

WHAT TO LOOK FOR IN YOUR ONLINE GRADE BOOK

Please note that because the Online Course grade book only shows the completion status of assignments at the lecture level, you may not see a change in your grade book unless you have actually completed an assignment for the whole lecture offline (either homework or viewing lectures). If you have only completed some of the topics, check the topic status of individual lectures (in your weekly assignment page). If, at the very least, you have not completed the assignments of a whole topic you may not see any changes in your Online Course.

Please also refer to the **Rules Used to Import Your Statistics** section.

UPLOADING ERRORS

Following is a list of the possible errors generated by the **Import/Export/Upload Statistics Wizard** when uploading your statistics:

**Error Connecting to the Internet**

You will see this error screen if the Import/Export/Upload Wizard was unable to connect to the Internet. As mentioned previously, you MUST have access to the Internet to upload your statistics automatically. If you have Internet access from your computer, click **Back** and try again. Otherwise, refer to the **Uploading Your Statistics Manually** section for instructions on how to manually upload your statistics to your Online Course grade book.

**Incorrect User ID**

You will see an error message if the Import/Export/Upload Wizard was unable to verify your user ID. The most likely reason is that you have entered your user ID incorrectly. Try to enter your user ID again. If this problem persists, refer to the **Uploading Your Statistics Manually** section for instructions on how to manually upload your statistics to your Online Course grade book.

**Incorrect Password**

You will see an error message if the Import/Export/Upload Wizard was unable to verify your password. The most likely reason is that you have entered your password incorrectly. Double-check your password, and try again. If this problem persists, refer to the **Uploading Your Statistics Manually** section for instructions on how to manually upload your statistics to your Online Course grade book.

UPLOADING YOUR STATISTICS MANUALLY

If the **Upload to Online wizard** is unable to upload your statistics to your Online Course grade book automatically, please follow the steps below to upload them yourself:

1. If one of the previously described error screens is displayed, go to the **Transfer To/From Another Computer**.
2. Click **Export** and export your statistics preferably to your desktop.
3. Copy the exported file to a computer you normally use to access your Online Course portal (via flash drive, CD, or any other removable media you have access to).
4. Log on to your online course account. From your portal select the **Import Offline Statistics** link.
5. Click **Browse** and find the file you exported. See the **What to Look for in Your Online Grade book** section for information on what has been imported.
TRANSFER TO/FROM ANOTHER COMPUTER

This option allows you to transfer your statistics from one computer to another. To import or export your statistics, click the Transfer To/From Another Computer link on the Options tab of the Home Page.

How to Transfer Your Statistics

To transfer your statistics from one computer to another, follow these steps:

1. First, export your statistics from the computer you last used to study or the computer that has your statistics. See the Exporting Your Statistics section for instructions on how to export your statistics.

2. You must have access to the export file created in Step 1 from the computer in which you want to integrate the statistics. Copy the file onto a hard drive, flash drive, or CD, or send it to that computer as an e-mail attachment.

3. Finally, import the statistics saved in this file from the computer in which you want to integrate the statistics. See the Importing Your Statistics section on how to import your statistics.

Note: Importing statistics from another computer does NOT simply overwrite the existing statistics from the file you are importing. Rather, both statistics are merged, which results in a cumulative set of statistics from both sources, making this process simple and safe.

Note: Information stored in My Notes is not included when exporting or importing.
Rules Used to Import Your Statistics

Following is a list of the rules used in importing statistics. Please note that the term "target computer" refers to the computer to which you are importing the statistics.

- **Individual Question Statistics**
  Imported questions that have been answered are marked as answered in the target computer regardless of their current status.

  The first session status of imported questions is set accordingly (to correct or incorrect) ONLY IF the question has not been answered in the target computer. Otherwise, this status is ignored.

  The last session status of imported questions is changed automatically. The assumption is that a homework session was last conducted on another computer and is now being imported.

  The overall status of imported questions is changed ONLY IF the existing status is not correct. Otherwise, if the overall status of a question is correct, this is ignored. The reason is that once a question has been answered correctly once, it is counted as correct toward the overall statistics regardless of how the question is answered in future homework sessions (see the *How to Complete Homework* section earlier in this manual).

  The correct status of a question is changed ONLY IF the imported status is correct, and it is ignored otherwise. This status is used to distinguish questions for the *Incorrect/Unanswered Questions* filter.

  The number of times a question has been studied is NOT updated in the target computer during an import operation. Doing so allows you to import your statistics multiple times without distorting any values.

- **Lectures Viewed Statistics**
  The topics for which the lecture has been viewed are marked as complete in the target computer.

- **Homework Topic History Statistics**
  Topic History records from the import file are inserted in the target computer only when there are no matching statistics with the same date in the target computer.
Exporting Your Statistics

To export your statistics, click **Export** on the **Transfer To/From Another Computer** screen. You will then see the **Export Statistics** screen:

Your statistics will be exported to a special file and saved in a folder of your choice on your computer. The default name for the file is "BeckerCPAStats_mm_dd_yyyy. The default folder to save the file is your documents or my documents folder. You have the option to change either or both of these default settings. It is important to note where and under what name you have saved the file so you can access it easily to transfer to another computer. Click **Save**.

Importing Your Statistics

To import your statistics, click **Import** from on the **Transfer To/From Another Computer** screen. You will be asked to browse your computer for the file to import.

Once you have found the file, click **Open** to import the statistics from that file and merge it with the existing statistics on this computer. Note that you have the option to import your study plan details as well. Please see the **Rules Used to Import Your Statistics** section to see the rules used when importing your statistics.